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Notice 
The information contained in this manual is subject to change without notice.  Compact Data 
Works, Inc. makes no warranty of any kind with regard to this material, including, but not limited to, 
the implied warranties of merchantability and fitness for a particular use.  Compact Data Works, 
Inc. shall not be liable for errors contained herein nor for incidental or consequential damages in 
connection with the furnishing, performance, or use of this material. 
 
This document contains proprietary information which is protected by copyright.  All rights are 
reserved.  No part of this document may be photocopied or reproduced without the prior written 
consent of Compact Data Works, Inc. 
 
Trademarks  
 
TapeCopy is a trademark of Compact Data Works, Inc. 
 
Alpha AXP, DEC, DECnet,  VAX, VAXcluster, VMS, OpenVMS are registered trademarks of 
Hewlett-Packard Corporation. 
 
Windows is a registered trademark of Microsoft Corporation. 
 
 

 
 
 
 

Copyright 2012-2014 Compact Data Works, Inc. 
 

All Rights Reserved 
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TapeCopy for Windows 
Introduction to TapeCopy 

TapeCopy allows tapes written by VMS BACKUP to be read directly on a Windows computer and 
allows the files in the BACKUP savesets to be copied and converted for use on Windows, 
 
TapeCopy works with all tapes written by VMS BACKUP and supports tapes written with any block 
size including 64K bytes.  Savesets which span multiple tapes are supported. 
 
TapeCopy also provides for the backup savesets on a tape to be copied to a Windows disk for 
restoring of files at a later time without the need to reread the tape. 
 
TapeCopy converts any VMS file for use on Windows.  All RMS file organizations are supported 
including sequential, relative, and indexed. 
 
TapeCopy provides a Graphical User Interface, like an explorer, which provides visibility to the tape 
and saveset contents. 
 

 

Tape drives supported 
TapeCopy will work with any tape drive that Windows sees.  It has been tested extensively on the 
following tape drives: 
 

• 4 mm 
• 8 mm 
• DLT 
• IBM 3490 

 
 

 
 

TapeCopy License 
TapeCopy requires a license to run.  The initial temporary license installed with a download is good 
for 30 days.  The Welcome dialog that is displayed when this programs first runs tells you when the 
license will expire.   
 
In order to obtain a permanent license, you will need provide Compact Data Works with your 
system ID.  This is obtained by selecting License File from the Help menu.  A small dialog will 
appear giving the system ID information.   
 

 
 





 

Reading Tapes 
Selecting a tape drive  

You need to select a tape drive before you can do anything.  Upon starting TapeCopy, a dialog is 
presented with a list of available tape drives.  Select the one you want to use. 
 

You may, of course, change this at  any time by selecting the   icon. 
 

 

Scanning for savesets   
This action reads the entire tape looking for saveset headings only.  It skips tape marks and is very 
fast to process an entire tape.  Each saveset encountered will be listed on the left side of the 
TapeCopy display.   No directories or files are listed as they are skipped between tape marks. 
 
You may then  view the saveset summary by selecting  a saveset and using either the View menu, 

a right click,  or the   icon. 
 
 

 

Listing a tape  
This action will read an entire tape, multiple volumes if necessary, and list each saveset and its 
contents on the  TapeCopy display.  At the same time, it will also create a TapeList file for later use. 
 This file may then be viewed at any time to see the contents of the tape.  Individual files or 
directories may be restored using the TapeList file.  Files may also be restored as soon as the tape 
is listed. 
 
To restore files immediately, select the files to be restored and then use the Restore Menu or select 

the   icon 
 

To restore files at a later time from a TapeList file use the Restore menu or select the  icon. 
 
 

 

Copying savesets  
This action will copy all the savesets found on the tape to disk.  These can then be used for 
restoring files.  This is the fastest to way to restore files at a later time because no tape is required. 
 The disk address of each file is stored in the SaveSet file making restoring a file very fast.  All of 
the file data is copied.  The files created are called SaveSet files to differentiate them from VMS 
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BACKUP savesets.  They contain all the same data but in a slightly different format, i.e., they could 
not be copied to VMS and read with BACKUP. 
 

To see the contents of SaveSet file, use the Restore menu or the icon.  You may then select 

files or directories to restore and use the  icon. 
 
 

 

Nonrecoverable Errors 
Some tape errors are detected by the Windows drivers and TapeCopy cannot recover from them 
 TapeCopy will advance the tape to the next tape mark and attempt to continue at this point if there 
is another saveset on the tape.  Otherwise the  current action will be terminated,  These include the 
following: 
 
Error Code 23 - CRC error 
 
Error Code 1117 - device I/O error 
 

 



 

TapeCopy Display 
TapeCopy display 

The TapeCopy display is an explorer type display with the savesets and directories listed on the left 
side (tree view) of the display.  The right side 
(file view) of the display lists the files contained in the directory selected on the left side.    To view 
a different directory simply click on it. 
 
Files are selected to be restored from this display. 
 

 

Status bar 
The status bar at the bottom of the screen is used to display current tape status, ie, rewinding tape, 
scanning saveset etc.  While files are being restored, the name of each file is displayed. 
 

. 

? Help  
This icon can be used to view a short description of any other icon on the display.  Simply click on it 
and drop it on another icon. 
 

. 

7 





 

9 

Viewing Tape Details 
View saveset summary  

To view the saveset summary, select a saveset in the display tree and use the View menu, a right 

click, or the   icon..  A summary dialog will be presented.  The contents are what VMS BACKUP 
would display if you were to list the tape on a VMS system. 
 

 

View file properties  
To view the file details of a given file, select a file in the file display and use the View menu, a right 

click, or the   icon..  A  dialog will be presented.  The contents are similar to what would be 
displayed on a VMS system using a DIRECTORY/FULL command 
 

 

Current tape position  

The current tape position may be displayed using the   icon..  The current tape device is 
displayed as well as the current volume number, saveset number on that volume and block number 
within the current saveset. 
 

 





 

Restoring Files 
Restore an entire tape  

To restore an entire tape, simply insert the tape in the drive and use the Action menu or the   
 icon.  You will be presented with a dialog requesting the starting destination directory.   The 
contents of the tape will be restored there.  Directory structure is preserved.  Multiple version 
numbers are not restored;  only the highest version of a file is restored.   
 
System files are not restored.  These include files from SYS$SYSTEM, SYS$MANAGER, 
VMS$COMMON for example. 
To restore lower version numbers or any system file you will need to restore using a TapeList 

  or a Saveset  file and select the particular file that you want restored. 
 

 

Restore using a TapeList file  

To restore using a TapeList file, first open the TapeList using the   icon.  Select the files or 

directories that you want to restore.  Then use the   icon.  If the tape to be used is not in the 
drive, you will need to insert it.  If the files to be restored reside on a tape that is not the first tape of 
a set, you will be prompted which tape to insert.  A dialog will be presented requesting the 
destination directory. 
 
As the files are restored, the status bar will contain the name of the current file being restored. 
 
If you are restoring a directory, the tree structure will be preserved.  The file dates of each restored 
file are set to the dates of the files as they reside on the tape. 
 

 

Restore using a SaveSet file  

To restore using a SaveSet file, first open the SaveSet using the   icon.  Select the files or 

directories that you want to restore.  Then use the   icon.  You do not need a tape when 
restoring from a SaveSet file  A dialog will be presented requesting the destination directory. 
 
As the files are restored, the status bar will contain the name of the current file being restored. 
 
If you are restoring a directory, the tree structure will be preserved.  The file dates of each restored 
file are set to the dates of the files as they reside on the tape. 
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Restoring files  

To restore a file, simply select it (highlight it) and then click the  icon.  You may select many 
files.  A dialog will be presented which allows you to choose the destination folder.  As files are 
restored, the name of each restored file will be displayed on the Status Bar. 
 

 

Restoring a directory  
To restore a directory, simply select it (highlight it) on the left side (tree) of the display and then 

click the  icon.  A dialog will be presented which allows you to choose the destination folder.  If 
the directory selected contains other directories, they will also be restored.  The tree structure will 
be preserved. 
 
As files are restored, the name of each restored file will be displayed on the Status Bar. 
 

 
 



 

Controlling TapeCopy 
Loading a tape 

There is no direct action for loading a tape.  Simply insert the tape into the drive and select one of 
the read actions (list tape,  copy savesets, or restore tape ).  TapeCopy will then take care of 
loading the tape. 
 

 

Rewinding a tape  

To rewind the current tape, select the  icon or use the Action menu,  The status bar will display 
"Rewinding tape". 
 

. 

Ejecting a tape  

To eject the current tape, select the  icon or use the Action menu,  The status bar will display 
"Tape is ejected" after the tape is rewound and ejected. 
 

. 
 

Stopping an operation  

To stop any given operation, select Stop from the Action menu or use the  icon..  This will abort 
any read or restore operation.  This is very handy if you accidently start the wrong action or realize 
the tape you are reading is not the one you want. 
 
You cannot, however, stop certain tape actions such as rewind or eject  There may also be times 
when it appears that you cannot stop a read operation.  This can happen if the driver software is 
having trouble reading a particular block on the tape.  Usually the operation recovers.  If there is an 
unrecoverable error, this will be displayed. 
 
 The status bar will display "Aborting operation". 
 

. 
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VMS File types supported 
VMS File Types 

VMS supports 3 different file organizations and many record types within each organization. 
 TapeCopy can convert all of these file types to Windows format.   
 

File organization VMS record type TapeCopy conversion 

Sequential Files  

 Variable length records 

 Fixed length records 

 Stream 

 Stream-CR 

 Stream-LF 

 FTN 

 VFC 

  

Relative Files  

 Variable length records 

 Fixed length records 

  

Indexed files  

 Variable length records 

 Fixed length records 

 Compressed Keys 

 Compressed Index 

 Compressed Data 

 
 

VMS version numbers 
BACKUP tapes are likely to contain many versions of any given file.  If you are restoring an entire 
tape, TapeCopy will only restore the highest version of any file.  If you wish to restore a lower 

version, you will need to restore from a SaveSet  or restore from a TapeList .  Even then, if 
you select many versions of a file, TapeCopy will still only restore the highest version selected. 
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